
 
MOTOMESH Duo™ Wireless Mesh Product, Version 2.1.0 

 1 

MOTOMESH Duo Release Notes for Version 2.1.0 
 

 

The MOTOMESH Duo 2.1.0 release is a maintenance release for the MOTOMESH Duo 
product.  The MOTOMESH Duo Product Line is distributed by Motorola Inc. 
New Version: R2.1.0 
Old Version:   R2.0.2 
 

Specific version numbers of software and firmware are included in this release for each 
system component. 
 
Description: This release includes the following components and version numbers: 
MOTOMESH Duo Firmware              9.1.44 
Wireless Management System (WMS)  1.0.18 
MOTOMESH Link Monitor   2.2.12 
 
 
These release notes are separated into 3 categories: 

 
1) Existing Issue: This is an issue that contains a workaround and was previously 

noted in a prior release 
 
2) Known Issue: This is a known issue that has a workaround, may exist in a 

previous release and was not noted in previous Release Notes. 
 
3) Updated issue: These are issues that were noted in previous releases but have 

been fixed in this release.   
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Existing Issue  

Note #: E-1 

Abstract: 
 
Reference Number: 

Description of the factory default and upgrade behavior of 
the Adaptive Noise Immunity (ANI) mode. 
PR 2034, 2048, 2370 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

Refer to the user guide for detailed ANI configuration 
description.  

User Symptom: The ANI mode may be modified upon upgrading to firmware 
version 9.1.44.   

Description: The tables below describe the behavior of the ANI settings. 
 

ANI Mode Factory Default Value 

Firmware 

version 
Per Unit / 

Per Radio 

802.11a 

Radio 

802.11b/g 

Radio 

9.1.44 Per Radio Disabled Disabled 

9.0.7x Per Radio Disabled Disabled 

9.0.60 Per Radio Enabled Enabled 

9.0.51 Per Unit Enabled 

1.0.42 Per Unit Disabled  

ANI Mode After Upgrade Upgrade 

Firmware to 

9.1.44 

From Version 

802.11a Radio 802.11b/g Radio 

9.0.7x No override – last 

used 9.0.7x value 

No override – last 

used 9.0.7x value 

9.0.60 No override – last 

used 9.0.60 value 

No override – last 

used 9.0.60 value 

9.0.51 No override – last 

used 9.0.51 value 
Disabled 

1.0.42 No override – last 

used 1.0.42 value 
Disabled 

Work Around: Adjust the ANI mode to the desired value if needed. 

Client Radios: In certain high noise environments and where client performance is not what you’re 

expecting, enabling ANI on the 2.4 client radio may improve performance.   

Backhaul Radios: In certain high noise environments where inter-nodal backhaul performance is not 

what you’re expecting, enabling ANI on the backhaul radio may improve performance.  

NOTE: If your inter-nodal links have poor RSSI levels and you enable ANI, you may lose 

communication to that or any neighboring devices, making them inaccessible. This may result in 

isolated devices which could require over-the-air proximity access to the webpage to disable ANI. 

Use caution when enabling ANI on devices with marginal inter-nodal links. 
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Existing Issue  

Note #: E-2 

Abstract: 
 
Reference Number: 

Error message indicating failure to resolve nearby device by 
DNS. 
PR 964 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

Link Monitor  

User Symptom: Attempting to resolve the IP address of nearby devices via 
DNS will display error message indicating failure to resolve 
device. 

Description: If you try to resolve the IP address of a nearby device, the 
DNS resolution may fail under specific circumstances. 

Work Around: Ensure that the DNS configuration for the computer, and for 
the computer's network adapter don't use hard-coded DNS 
suffixes. Ensure that the computer’s DNS suffix is 
configured via DNS.  
For Windows XP, check the following items: 
1) Control Panel -> System Properties -> Computer Name -
> Change -> More : Make sure that the "Primary DNS suffix 
of this computer" is blank 
2) Control Panel -> Network Connections: Right click on the 
network adapter and select Properties. On the General tab, 
scroll down to and highlight Internet Protocol (TCP/IP), and 
select Properties. On the Internet Protocol (TCP/IP) 
Properties page, select Advanced. On the Advanced 
TCP/IP Settings page, select the DNS tab. Make sure that 
"Append these DNS suffices" is NOT selected or set "DNS 
suffix for this connection" to the DNS name for the network 
being tested. 
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Existing Issue  

Note #: E-3 

Customer / Internal:  

Abstract: 
 
Reference Number: 

The web interface supports only the Internet Explorer (IE) 
web browser. 
 
PR 1315, 2406, 2808 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: The web interface page times out when using a web browser 
other than IE. 

Description: The MM Duo web interface supports IE. Other web browsers 
may or may not work. 

Work Around: Use IE web browser to access the web interface. 

Engineering Details:  

 
 

Existing Issue  

Note #: E-4 

Abstract: 
 
Reference Number: 

Changing WEP setting on one VAP changes WEP setting 
on all VAPs. 
PR 567 

System Platforms 
Affected: 

 
MOTOMESH DUO 

Special 
Configurations: 

WEP Authentication on more than one VAP. 

User Symptom: Changing WEP settings for one VAP will change the WEP 
settings for all VAPs that use WEP authentication. 

Description: There are no unique WEP settings per VAP. If WEP 
authentication is to be used on more than one VAP, all of 
them have to share one common WEP settings. 

Work Around: Other authentication types such as PSK or WPA can be 
used and can be unique per VAP. 
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Existing Issue  

Note #: E-5 

Abstract: 
 
Reference Number: 

Some client cards may be unable to receive traffic when 
QoS is enabled on the client card. 
PR 2503 

System Platforms 
Affected: 

 
MOTOMESH DUO 

Special 
Configurations: 

 

User Symptom: A client card that has QoS enabled fails to receive traffic 

Description: A client card that has QoS enabled may fail to receive traffic 
with priority of 1-6 sent to it from a MM Duo AP 

Work Around: Disable QoS on the client card. 
  

 

Existing Issue  

Note #: E-6 

Abstract: 
 
Reference Number: 

The Web interface doesn’t expose the MSR Proxy Init Table. 
 
PR 971 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

n/a 

User Symptom: User won’t be able to specify devices to be proxied for by the 
unit. 

Description: The MM Duo unit will lose track of a proxy that rarely 
generates traffic (not chatty). Adding an entry in the MSR 
Proxy Init Table prevents this from happening. The web 
interface lacks this mechanism. 

Work Around: WMS (or the use of SNMP scripts) can provide this 
functionality. 
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Existing Issue  

Note #: E-7 

Abstract: 
 
Reference Number: 

Possible no boot situation if 1-ap30.dld doesn’t exist. 
 
PR 1642 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

Using Reset Factory Plug when 1-ap30.dld doesn’t exist. 

User Symptom: The device is non-functional, inaccessible, and irrecoverable.  

Description: When uploading a firmware image to the device, the image 
name should not be changed from the default of ap30.dld. 
When uploaded, the firmware will be automatically renamed 
to reflect the firmware slot where it is stored (1-ap30.dld is 
the default ap30.dld file stored in slot 1). If the firmware 
filename was renamed from defaults prior to uploading or the 
unit has no images named 1-ap30.dld and a factory reset 
plug is used to restore the 2.0 hardware back to factory 
defaults, the device won’t boot and will be unmanageable. 

Work Around: The device is capable of holding two binaries. One must 
always be named 1-ap30.dld. Don’t rename the default files. 
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Existing Issue  

Note #: E-8 

Abstract: 
 
Reference Number: 

Horizontal Scrollbar on Route Table & Neighbor Table 
windows resets to far left position 
PR 1111 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

Link Monitor 

User Symptom: If you adjust the scroll bar on the route table or neighbor 
table to the right of the default far left scroll position, it may 
reset to the far left default position without the user taking 
any action. 

Description: Whenever a device query update occurs, the neighbor and 
route tables get re-written, which causes the horizontal scroll 
bar to be reset to its far left default position. 

Work Around: Either pause the monitor, or change the refresh interval to a 
value that is long enough to allow you to complete the scroll 
operation and view the data before another device query 
completes. 

 

 

Known Issue  

Note #: K-1 

Abstract: 
 
Reference Number: 

False backhaul failure detection under heavy backhaul traffic. 
 
PR 1860 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: Loss of the backhaul connection and interrupted service and 
manageability while the IAP converts to a WR. 

Description: When the backhaul connection is saturated, there’s a 
potential that the backhaul “heart beat” ping responses from 
the target are lost causing the IAP to falsely detect backhaul 
failure. Note: Saturating the backhaul connection may be a 
rare event since most applications are TCP based. 

Work Around: � Configure the target of the backhaul “heart beat” ping to 
send ICMP traffic at high priority.  

� Modify the backhaul parameters to account for the 
potential loss. 
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Known Issue  

Note #: K-2 

Abstract: 
 
Reference Number: 

RTS threshold changes when meshing is enabled/disabled 
 
No PR 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: In a fairly busy RF environment, when meshing is disabled, 
transmitted frames may exhibit higher drop and corruption 
rates. 

Description: When meshing is disabled, the RTS threshold is set to 2347 
bytes for the radio. When meshing is enabled, RTS threshold 
is set to 64 bytes for the radio. 

Work Around: When meshing is disabled, the RTS threshold is configurable 
and can be set to the desired value. 

 
 
 

Known Issue  

Note #: K-3 

Abstract: 
 
Reference Number: 

The SSID for the recovery VAP has been changed  
 
PR 1378 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: The Ethernet MAC address of the AP must be known in order 
to access the recovery VAP. 

Description: The SSID for the recovery VAP has been changed to the 
Ethernet MAC address "XX:XX:XX:XX:XX:XX" of the AP 

Work Around: The recovery VAP SSID is configurable and may be set to 
the desired value 
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Known Issue  

Note #: K-4 

Abstract: 
 
Reference Number: 

DiffServ to 803.2p mapping is Configurable 
 
No PR 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

VLAN tagging is enabled 

User Symptom: User can change the default DiffServ to 802.1p mapping for 
the MM Duo AP.    

Description: When using VLAN tags, the default DiffServ to 802.1p 
mapping is as follows: 
 
 Default MAP (DSCP 0x00 - 0x3F): 
 0x00:  0, 0, 0, 0, 4, 4, 4, 4, 0, 0, 0, 0, 4, 4, 4, 4          
 0x10:  0, 0, 0, 0, 4, 4, 4, 4, 3, 0, 0, 0, 4, 4, 4, 4          
 0x20:  4, 0, 0, 0, 4, 4, 4, 4, 5, 0, 0, 0, 4, 4, 4, 4          
 0x30:  6, 0, 0, 0, 4, 4, 4, 4, 7, 0, 0, 0, 4, 4, 4, 4 
 

Work Around:  

 
 
 

Known Issue  

Note #: K-5 

Abstract: 
 
Reference Number: 

Devices experience reboot delay after upgrade  
 
No PR 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: Inaccessible devices and loss of communication  

Description: When upgrading MOTOMESH Duo firmware from versions 
older than 9.1.44, the upgrade reboot cycle will delay startup 
by at least six minutes. This is to allow the upgraded nodes to 
be aged out of the group of any existing network nodes that 
are NOT going to be upgraded at the same time. Failure to 
age out upgraded nodes would result in network bridging 
loops. 

Work Around:  



 
MOTOMESH Duo™ Wireless Mesh Product, Version 2.1.0 

 10 

 

Known Issue  

Note #: K-6 

Abstract: 
 
Reference Number: 

Firmware version 9.1.44 is not backward compatible.  
 
No PR 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: Inaccessible devices and loss of communication  

Description: This firmware version is incompatible with 9.0.x firmware 

Work Around:  

 
 

Known Issue  

Note #: K-7 

Abstract: 
 
Reference Number: 

Web interface channel list may include invalid channels. 
 
PR 2516 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: When using the web interface, setting the channel to a 
frequency chosen from the channel list may fail. 

Description: The channel list on the Web interface is static; it includes all 
valid channels for all regulatory domains. The available 
channel list is not dynamically updated to display only valid 
channels for a certain country. The user may chose an invalid 
channel to be set but the device will fail the request  

Work Around: Refresh the web page after a channel switch request in order 
to confirm the active/current channel. A failure to set a 
channel may be an indication of an invalid channel. 
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Known Issue  

Note #: K-8 

Abstract: 
 
Reference Number: 

The MM Duo 4.9 GHz channel numbering scheme has been 
changed which may cause some stations to fail to associate 
with the AP 
 
PR 1480, 2706 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

4.9 GHz radio, suppressed SSID  

User Symptom: 4.9 GHz station cards not adhering to the IEEE 802.11 2007 
standard channel numbering scheme will be unable to 
associate with VAPs that have SSID suppression enabled. 

Description: The 802.11-2007 was recently ratified states in Annex J the 
proper channel numbers in the US for 4.9 GHz. MM Duo 4.9 
GHz channel numbering complies with the standard and is 
implemented as follows: 
 
For US, the following applies: 
 
Starting Freq (MHz)   Channel Spacing (MHz)    Channels 
---------------------------  --------------------------------    ----------------------- 
 4890                            10                                     11, 13, 15, 17, 19 
 4850                            20                                     21, 25 
 
Calculated US Channel Frequencies: 
 
    Channel   Frequency  
      11         4945    
      13         4955  
      15         4965  
      17         4975  
      19         4985 
 
      21         4955 
      25         4975 

Work Around: To work around the incompatibility issue, do one of the 
following: 
1) Upgrade station card software to IEEE 802.11-2007 
standard compliant software. 
2) Disable SSID suppression on VAP 15 for the 802.11a 
radio. 
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Known Issue  

Note #: K-9 

Abstract: 
 
Reference Number: 

Enabling meshing requires the existence of an active VAP on 
the radio  
 
PR 2783 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: Unable to turn on meshing on the radio. 

Description: If a MM Duo device boots up with no active VAPs on a radio 
(default for 4.9 GHz units), then meshing can’t be enabled on 
the radio without first enabling a VAP and rebooting the unit.  

Work Around: 1) Activate any VAP on the desired radio  
2) Reboot the unit 
3) Enable meshing on the desired radio 
4) Deactivate any unwanted VAPs. 

 
 
 

Known Issue  

Note #: K-10 

Abstract: 
 
Reference Number: 

Netperf tool throughput may not reflect the maximum link 
throughput capacity  
 
PR 2572, 2771 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

Netperf server or client resides on a MM Duo unit. 

User Symptom: Netperf throughput may be lower than expected and doesn’t 
reflect the actual link capacity. 

Description: Depending on the configuration and the run test, the Netperf 
calculated link throughput won’t exceed 12Mbps. 

Work Around:  
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Known Issue  

Note #: K-11 

Abstract: 
 
Reference Number: 

Web interface doesn't provide warning prompts  
 
PR 2792 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: No warning prompts for invalid parameters or an invalid 
configuration and the applied changes don’t take effect. 

Description: On the web interface there’s  no prompt: 
1) If any of the following mesh security parameters are 

entered with an invalid length: PSK Pass Phrase, R0 
Key Holder ID, Mobility Domain Identifier, and Group 
Master Key. 

2) When a user attempts to disable encryption, the 
authentication type is already set to something other 
than open, and the proper sequence isn’t followed. 

 
In either case the device doesn’t accept the change. 
However, the user doesn’t get a notification of the failure. 

Work Around: 1) Upon loading the mesh security page, the mesh 
security fields are populated with space-delimited, 
length-matching zeros as a hint. In addition, the fields 
are all labeled with the required length. 

2) A chart of all valid authentication parameter 
combinations are provided on the Mesh security tab. 
The correct sequence to disable encryption is as 
follows: 

a. Change the encryption type to open. 
b. Apply the changes. 
c. Disable encryption. 
d. Apply changes.  

3) After applying changes, if the modifications are not 
reflected on the page, this is an indication of a failure. 
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Known Issue  

Note #: K-12 

Abstract: 
 
 
Reference Number: 

WMS: No method provided to add or delete configuration 
parameters to existing templates 
 
PR 1827 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: For an existing configuration template, there is no method 
provided to allow the user to add new configuration 
parameters or to delete configuration parameters from the 
template. 

Description: WMS does not provide a method to add or delete 
configuration attributes to existing templates. 

Work Around: Create a new template that includes all of the desired 
configuration parameters. 
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Known Issue  

Note #: K-13 

Abstract: 
 
 
Reference Number: 

WMS: Historical Client Statistics are not available when WMS 
is configured to use SNMPv1 or SNMPv2. 
 
No PR 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: Historical Client Statistics are not available if WMS is 
configured to use SNMPv1 or SNMPv2 to communicate with 
MOTOMESH Duo devices. 

Description: Historical Client Statistics include Counter64 statistic 
parameters that are only supported by SNMPv3. If WMS is 
configured to communicate to your MOTOMESH Duo 
devices using SNMPv1 or SNMPv2, then WMS will not be 
able to collect Historical Client Statistics because they are 
only available when SNMPv3 is used. 

Work Around: Configure WMS to communicate with MOTOMESH Duo 
devices using SNMPv3. 
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Known Issue  

Note #: K-14 

Abstract: 
 
 
 
 
 
 
Reference Number: 

WMS: When using SNMPv3 with multiple Class B networks… 
1. Discovery does not start after adding second Class B 

network in Discovery Configurator. 
2. WMS hangs when attempting to load runtime 

administration. 
3. Unable to start WMS services. 

 
PR 1643, 1713 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

Using SNMPv3 on network devices and configuring multiple 
Class B networks in Discovery Configurator. 

User Symptom: If your network devices are using SNMPv3 and you attempt 
to configure discovery of more than one Class B network 
using the Discovery Configurator, you may notice one or 
more of the following symptoms: 

1. Discovery does not start after adding second Class B 
network in Discovery Configurator. 

2. WMS hangs when attempting to load runtime 
administration. 

3. Unable to start WMS services. 

Description:  

Work Around: When network devices are configured to use SNMPv3, you 
can only configure Discovery Configurator to discover a 
single Class B network. A single Class B network can be 
discovered. All other devices that do not belong to the 
discovered network must be added manually via the 
Discovery Configurator using "Add Node". 
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Known Issue  

Note #: K-15 

Abstract: 
 
 
Reference Number: 

WMS will not discover additional devices because licensed 
limit has been reached. 
 
PR 2797 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: WMS does not discover new devices even though everything 
is configured properly. No error or other indication is given 
other than WMS will not discover new devices. 

Description: When you reach the licensed device count limit, WMS will not 
discover new devices, but no error or other indication is given 
when this occurs. 

Work Around: Be aware of your licensed device count limit. When you have 
reached the device count limit, purchase a new license with a 
larger device count. 
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Known Issue  

Note #: K-16 

Abstract: 
 
 
Reference Number: 

WMS: Attempting to reboot a device using Configure Device 
fails to reboot the device 
 
PR 2711 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: Attempting to reboot a device using Configure Device fails to 
reboot the device even though the reboot parameter is set to 
true. 

Description: If you attempt to use the Configure Device command to 
reboot a device, even though you have set the reboot 
parameter to true, the command will only get sent to the 
device the first time you change it from false to true. On 
subsequent attempts, the database value is already set to 
true (from the previous use) so WMS will not send the reboot 
command to the device. 

Work Around: Do not use the Configure Device command to reboot a 
device. Instead, select the device and then use the “Reboot 
Device” command available in the “Tools” context menu. This 
method also allows you to select more than one device to 
reboot. 
 
You can also use a configuration template to initiate a device 
reboot. Whenever the reboot parameter is included in a 
configuration template, the reboot will be performed. 
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Known Issue  

Note #: K-17 

Abstract: 
 
 
Reference Number: 

WMS: During Rediscovery configuration, changing "Hours" to 
"All" makes selection of "Days"/"Dates" impossible 
 
PR 2494 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: When you are configuring rediscovery in the Discovery 
Configurator, changing "Hours" to "All" makes selection of 
"Days"/"Dates" impossible. 

Description: Steps to reproduce: 
 
1. Go to "Tools" > "Runtime Administration". 
2. Expand "Topology" and select "Discovery Configurator". 
3. Click on "Rediscovery" button. 
4. Select "Specific Dates" radio button. 
5. Verify "Dates" and "Hours" box has "Specific" radio button 
selected. 
6. Change "Hours" to "All". 
7. Click on any dates under "Dates" box. 
8. Dates cannot be selected. 

Work Around: You can select the dates if the hour box (radio button) is not 
selected at all. After selecting the dates you can specify the 
hour. 
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Known Issue  

Note #: K-18 

Abstract: 
 
 
Reference Number: 

WMS: Resizing column in inventory panel results in 
ArrayIndexOutOfBounds when hovering at right end 
 
PR 2478 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: Steps to reproduce: 
 
1. Select Inventory. 
2. Verify "MAC Address", "Device Name", "IPAddress", 
"Status", "Device Type" columns shown in order. 
3. Resize "Status" columns to become smaller so that there is 
empty space created after "Device Type". 
4. Move mouse cursor to the right border of "Device Type". 
5. Verify from Java console output that multiple 
ArrayIndexOutOfBounds has occurred. 

Description: Resizing “status” column in inventory panel results in 
ArrayIndexOutOfBounds when hovering at right end 

Work Around: None. This is a non-fatal issue, no functionality is lost. 
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Known Issue  

Note #: K-19 

Abstract: 
 
 
Reference Number: 

WMS: Have only 2 devices in Inventory. Delete one of them; 
both are then deleted. 
 
PR 2413 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: You have only 2 devices listed in the device inventory, you 
delete one of them, and it then appears that both devices get 
deleted. 

Description: If you only have 2 devices listed in the device inventory, and 
you delete one of them, it appears that both devices get 
deleted, but the second device is not really deleted. 

Work Around: The second device is not really deleted; it’s just a display 
issue. Just click on another branch in the tree and then return 
to the inventory branch, or close the inventory branch and re-
open it. The second device that you did not delete will 
reappear. 
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Known Issue  

Note #: K-20 

Abstract: 
 
 
Reference Number: 

WMS: "Save" button is disabled when the "Collected Graph 
Viewer" is first displayed. 
 
PR 2310 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: Steps to reproduce: 
 
1. Go to "Performance" > "Configured Collection". 
2. Select one of the hosts. 
3. Select one of the statistics (e.g. Rx Bytes) > right-click > 
"Plot" > "Collected Statistic" 
4. Verify the graph is generated. 
5. "Save" button on upper left is disabled. 
6. Change to another graph type and return to the previous 
one. 
7. "Save" button is enabled. 

Description: The “Save” button is disabled when the “Collected Graph 
Viewer” is first displayed. 

Work Around: Change to another graph type and then return to the previous 
graph type; the “Save” button will then be enabled. 
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Known Issue  

Note #: K-21 

Abstract: 
 
 
Reference Number: 

WMS: Unable to configure more than 7 VAPs using 
templates 
 
PR 2111 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: When you attempt to use a template to configure more than 7 
VAPs on a device that is running firmware 9.1.x, the 
operation fails. 

Description: For devices running 9.1.x firmware, WMS is only able to 
configure up to 7 VAPs at a time using templates.  

Work Around: If you need to configure more than 7 VAPs on a device, use 
two separate templates with each holding up to 7 VAP 
definitions. 

 

 

 

Known Issue  

Note #: K-22 

Abstract: 
 
 
Reference Number: 

WMS keeps displaying the busy cursor after selecting 
“View -> Statistics” for a selected device in the Inventory. 
 
PR 2059 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: After selecting “View -> Statistics” for a device selected in the 
inventory, WMS will open the “Configured Collection” window 
for the device and then continuously display the busy cursor. 

Description: WMS keeps displaying the busy cursor after choosing “View -
> Statistics” for any device in Inventory. 

Work Around: This is just a display issue. Pressing the “Stop” button will 
stop the busy cursor. 
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Known Issue  

Note #: K-23 

Abstract: 
 
 
Reference Number: 

WMS: When you right-click on the MOTOMESH DUO 4300 
tree branch, the events and alerts count is always zero  
 
PR 1874 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: When you right-click on the "MOTOMESH DUO 4300" tree 
branch and select "Events And Alarms" > "Count", the count 
of events and alerts will be 0 even if there are events and 
alerts for MOTOMESH DUO 4300 devices. 

Description: Events and alerts count is zero when right-click on 
MOTOMESH DUO 4300 branch even if there are events and 
alerts. 

Work Around: Right-click the “DUO IAP” or “DUO WR” branch instead to 
determine total count by MOTOMESH DUO 4300 device 
type. 
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Known Issue  

Note #: K-24 

Abstract: 
 
 
Reference Number: 

WMS: Security Administration - excluded Change Password 
option is allowed anyway 
 
PR 1576 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: To reproduce: 
 

1. Create new Group (example: newgroup) and exclude 
'Change Password' from Operation Tree Root 

2. Add Group to Users (example: newuser) 
3. Verify 'Change Password' is excluded from the 

Permitted Operations for User tab 
4. Login newuser 
5. newuser is allowed to change password 

Description: WMS users are allowed to change their own password even 
if “Change Password” is not enabled in their user account 
security permissions.  

Work Around: None; all users are allowed to change their own password. 
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Known Issue  

Note #: K-25 

Abstract: 
 
Reference Number: 

WMS: “Trap Parser Configuration” window sometimes does 
not display trap list 
 
PR 2505 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: Sometimes the “Trap Parser Configuration” window does not 
display the configured traps. 

Description: The Trap Parser Configuration window does not always 
display the list of traps. If you open and close the window 
several times (Select Network Events in the tree, then select 
Edit -> Configure -> Trap Parsers), sometimes the window 
does not show any traps in the Configured Trap Parser List. 

Work Around: 1. In the Trap Parser Configuration window, click “Load 
From File”. A file dialog will open. 

2. Click “Load” button. A message dialog will open. 
3. Click “No” every time the message dialog shows. At 

the end you will see all the traps in the Configured 
Trap Parser List. 
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Known Issue  

Note #: K-26 

Abstract: 
 
 
Reference Number: 

WMS: Devices are not automatically discovered when they 
are configured to use SNMPv3 only 
 
PR 2585 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: You have configured your devices to use SNMPv3 only and 
you notice that they are not automatically discovered by 
WMS even though you have properly configured the 
discovery configurator. 

Description: By default, WMS is shipped to use SNMP broadcast to 
automatically discover network devices. The SNMP 
broadcast method only works for devices that are configured 
to use SNMPv1 or SNMPv2. If your network devices are 
configured to use SNMPv3, and you want WMS to 
automatically discover them, you will need to first disable the 
SNMP broadcast method. See work around below. 

Work Around: If you have configured your network devices to use SNMPv3 
only, then broadcast discovery needs to be disabled in the 
following configuration file: 
 
Linux: 
/usr/local/motorola/wms/server/conf/NmsprocessesBE.conf 
 
Windows:   C:\WMS\conf\NMSProcessesBE.conf 
 

Change the DISCOVER_BC_RESP_IPS parameter 

 

From: DISCOVER_BC_RESP_IPS true  

 

To: DISCOVER_BC_RESP_IPS false 

 
Another option is to configure your devices to use SNMPv1 
and SNMPv3. Using this strategy will allow WMS to discover 
new network devices using the SNMPv1 based broadcast 
method, and then perform all configuration tasks using 
SNMPv3. 
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Known Issue  

Note #: K-27 

Abstract: 
 
 
Reference Number: 

WMS: Attempts to connect to the WMS server from a remote 
web start client fail 
 
No PR 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: All attempts to connect to the WMS server from a web start 
client fail. 

Description: If you are running a remote web start client, you may not be 
able to connect to the WMS server if your network connection 
(between the client/server) does not allow all of the required 
TCP ports. 

Work Around: To allow the remote WMS web start client to start, the 
following ports are required to be open in your firewall 
connecting to the network: 
 
TCP Port Application 
9090  WMS 
32811  WMS 
8009  WMS 
8010  WMS 
8011  WMS 
1099  RMI (may not be required) 
1476  Config Server 
1482  Socket Server 
2000  NMS Back End Server (BE) 
6900  TFTP connection 
8001  North-bound Interface (NBI) 
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Known Issue  

Note #: K-28 

Abstract: 
 
 
Reference Number: 

WMS: “SQL syntax error” displayed after opening 
“Performance -> Configured Collection” 
 
7383 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: After opening “Performance -> Configured Collection”, a 
“SQL syntax error” message is displayed. 

Description: Using single quotes in device names will cause SQL syntax 
errors in the Performance Configured Collection feature. 

Work Around: Do not use single quote characters in device names. 

  
 

 

Known Issue  

Note #: K-29 

Abstract: 
 
Reference Number: 

WMS: Template Export asks for file name but ignores it.  
 
PR 2699 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: When exporting a template, you enter the name of the file to 
export to in the dialog; the template will not be exported. 

Description: When exporting a template, the user is prompted to enter a 
folder to export the template to, but the prompt is confusing 
because it also includes a “File Name” box.  

Work Around: When exporting a template, the user is prompted to enter a 
folder to export the template to.  
The dialog is titled “Select Template Export Folder”.  
The user must put the name of the folder in the “File Name” 
box, and not the name of the file as the prompt suggests. 
If you enter the name of a file in the “File Name” box the 
template will not be exported. You must enter the name of a 
folder. The filename will automatically be set to the name of 
the template with an “.xml” extension. 
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Known Issue  

Note #: K-30 

Abstract: 
 
 
Reference Number: 

WMS: MOTOMESH Device Web page does not allow device 
configuration changes to be made from the web browser 
 
No PR 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 
Using Mozilla/Firefox browser 

User Symptom: After selecting a MOTOMESH device in WMS, you launch a 
web browser using the “Launch Web Page” menu item. The 
device web page displays, but it does not accept any device 
configuration changes. 

Description: This only happens if the browser being used is 
Mozilla/Firefox. The MOTOMESH web page interface does 
not currently support Mozilla/Firefox. 

Work Around: 1. Launch the device web page from a Window-based 
WMS client, which will use Internet Explorer. 

2. Use the WMS Configure Device feature to make 
device configuration changes. 

3. Use the WMS Configuration Templates to make 
device configuration changes. 
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Updated Issue  

Note #: U-1 

Abstract: 
 
Reference Number: 

Web interface fails to load the 802.11a Radio Settings page. 
 
PR 1457 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: The 802.11a radio settings webpage is missing most of the 
fields.  

Description: Issue resolved. When accessing the 802.11a radio settings 
web page, some or all of the fields may not be displayed. In 
this release, all fields are visible on the 802.11a radio page.   

Work Around:  

 
 
 

Updated Issue  

Note #: U-2 

Abstract: 
 
Reference Number: 

The AP uses a low data rate for an extensive period of time. 
 
PR 1366 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: Low downstream throughput. 

Description: Issue resolved.  In harsh RF environments, the MM Duo AP 
used to use a low data rate for an extensive period of time 
when communicating with an associated station. In this 
release, the MM Duo AP will use the most optimal data rate 
to yield the best possible throughput. 

Work Around:  
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Updated Issue  

Note #: U-3 

Abstract: 
 
Reference Number: 

The Mesh security certificate field on the web interface is 
limited to a maximum of 256 bytes. 
PR 1846 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: Inability to load a certificate using the web interface. 

Description: Issue resolved. The Mesh security certificate field allows the 
user to input varying size certificates. Only a maximum of 256 
bytes of the certificate gets pushed to the device. In this 
release, a certificate up to 2KB in size can be pushed to the 
device. 

Work Around:  
 

 

Updated Issue  

Note #: U-4 

Abstract: 
 
Reference Number: 

Logical backhaul detection failure always occurs after 
recovering from a physical backhaul failure. 
 
PR 2002, 2418 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: Backhaul recovery is delayed after the physical connection is 
established. 

Description: Issue resolved. After recovering from a physical backhaul 
failure, the unit goes into a logical failure recovery mode. The 
recovery will depend on the backhaul detection configuration 
parameters. If the backhaul is functional, the device will 
recover in a very reasonable time. In this release, recovery 
from a physical backhaul failure is not followed by a logical 
backhaul detection failure. 

Work Around:  
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Updated Issue   

Note #: U-5 

Abstract: 
 
Reference Number: 

Inability to modify 802.11a VAP 3 configuration via the web 
interface 
 
PR 2438 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: Inability to modify VAP 3 configuration on the 802.11a radio 
via the web interface. 

Description: Issue resolved. Using the web interface to modify the VAP 
state (active/inactive) or the VAP AP state, the user is given 
the indication that the changes were applied successfully 
although this is not the case: when the VAP 3 page is 
refreshed, it’s noticed that the changes didn’t take effect. In 
this release, VAP3 configuration from the web interface is 
fully functional. 

Work Around:  

 
 

Updated Issue  

Note #: U-6 

Abstract: 
 
Reference Number: 

NetPerf doesn’t run from the web interface. 
 
PR 2200 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: NetPerf is configured from the web interface but the test fails 
to run.  

Description: Issue resolved. The web interface fails to push down the 
NetPerf configuration parameters to the device. 
Consequently, NetPerf fails to run. In this release, NetPerf 
can be run from the web interface. 

Work Around:  
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Updated Issue  

Note #: U-7 

Abstract: 
 
Reference Number: 

Accessing the web interface may cause a memory leak. 
 
PR 2419, 2467, 2514, 2405  

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: After a very high number of failed or stopped attempts to 
access the web interface, or having the web interface open 
for very long periods of time, the unit may become  
unresponsive. 

Description: Issue resolved. Every time an attempt to access the web 
interface fails (times out) or is stopped (by clicking the stop 
button on the web browser), a relatively small chunk of 
memory is lost. In this release, the memory leak is fixed. 

Work Around:  
 

 

Updated Issue  

Note #: U-8 

Abstract: 
 
Reference Number: 

The Network Discrimination feature no longer depends on 
the SSID.  
No PR 

System Platforms 
Affected: 

 
MOTOMESH DUO 

Special 
Configurations: 

Network Discrimination = Enabled 

User Symptom: Network discrimination doesn’t work as expected or has no 
effect. 

Description: The Network Discrimination feature no longer depends on 
the SSID but rather on the Mesh ID (previously known as 
LSA SSID) used for mesh security.  Mesh ID Discrimination 
is disabled by default and changing the MeshID only takes 
effect on reboot. The mesh ID will not be overridden on 
upgrades, attention must be paid to this field for proper 
operation of the network discrimination feature. 

Work Around:  
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Updated Issue  

Note #: U-9 

Abstract: 
 
Reference Number: 

Removed weather channels from 5.4 GHz Country Code 
tables. 
 
No PR 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

Unit operating in 5.4 GHz band. 

User Symptom: The 3 weather radar sub channels 120 (5600 MHz), 124 
(5620 MHz) & 128 (5640 MHz) are not available. 

Description: Issue Resolved. The following channels have been removed 
from all the Country Code tables: 
Channel/Frequency: 120/5600 MHz  
                                 124/5620 MHz  
                                 128/5640 MHz 
When upgrading from a previous version that support these 
channels, they are automatically disabled without any user 
provisioning. 

Work Around:  
 

Updated issue  

Note #: U-10 

Abstract: 
 
Reference Number: 

Meshing routes may break under heavy unregulated UDP 
Ethernet traffic. 
 
PR 1760 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: Sporadic brief interruptions in communication or short 
throughput outages. 

Description: Issue resolved. Flooding the Ethernet port of a MM Duo is 
with unregulated UDP traffic to be transported over the mesh, 
causes the transmit queues to overflow and hence to drop 
packets including vital routing packets. In this release, special 
handling of vital routing packets is added to avoid dropping 
them.  

Work Around: Note: it’s still recommended to avoid flooding the Ethernet 
port with unregulated UDP traffic. 
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Updated Issue  

Note #: U-11 

Abstract: 
 
Reference Number: 

Device reboots after a country code lock 
 
PR 2513 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: After locking the country code using the web interface, the 
device becomes inaccessible for brief period of time. 

Description: Issue resolved. Locking the country code via the web page 
causes the device to reboot without any prompts to the user.  
In this release, locking the country code from the web 
interface doesn’t cause the device to reboot and there’s no 
interruption in accessibility. 

Work Around:  

 
 
 

Updated Issue  

Note #: U-12 

Abstract: 
 
Reference Number: 

Inability to modify 802.11b/g VAP 2 configuration via the web 
interface 
PR 1849 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: Inability to modify VAP 2 configuration on the 802.11b/g radio 
via the web interface. 

Description: Issue resolved. On the 802.11b/g VAP2 web interface 
configuration page the “Action to Perform” field is disabled. 
This prevents a user from being able to modify the 
configuration of VAP 2. In this release, VAPs 1-15 are all 
configurable via the web interface.  

Work Around:  
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Updated Issue  

Note #: U-13 

Abstract: 
 
Reference Number: 

Ethernet port auto negotiation between a MM Duo IAP and 
an Adtran 1224STR switch is not fully supported. 
PR 1687, 1688 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: Port link lights may stay off or traffic between the MM Duo 
IAP and the Adtran switch is intermittent. 

Description: Issue resolved. When a MM Duo IAP is plugged into an 
Adtran 1224STR switch, the port lights may stay off or the 
traffic flow between the IAP and the switch is intermittent. In 
this release, support for Ethernet port speed and duplex 
mode configuration is added. This allows MM Duo to be 
configured for compatibility with the Adtran switch. 

Work Around:  
 

 

 

Updated Issue  

Note #: U-14 

Abstract: 
 
Reference Number: 

VAP 0 broadcasts an SSID but doesn’t allow station 
associations. 
 
PR 1710 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: Station cards are unable to associate with VAP 0 

Description: Issue resolved. VAP 0 broadcasts a SSID in its beacon. 
However, station associations are not allowed on this VAP. 
Thus any station card attempting to associate with the 
network advertised by VAP 0 will fail to do so. In this release, 
VAP 0 is deactivated if meshing is turned off. If meshing is 
turned on, VAP 0 SSID will be suppressed. 

Work Around:  
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Updated Issue  

Note #: U-15 

Abstract: 
 
Reference Number: 

Web interface gives no warnings of invalid 4.9 GHz channel 
 
PR 1728 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: User gets no warning when setting an invalid channel 

Description: Issue resolved. The available channels on the web interface 
for the 4.9 GHz band are fixed whether the channel width is 
10 MHz or 20 MHz. Hence, a couple of these channels (edge 
channels) are invalid when the channel width is 20 MHz. The 
web interface allows the user to set an invalid channel 
without any warnings. However, the device/firmware rejects 
the invalid channel value. In this release, the web interface 
displays only applicable channels depending on the channel 
width. 

Work Around:  

 

Updated Issue  

Note #: U-16 

Abstract: 
 
Reference Number: 

The power setting in the web interface is incorrectly displayed 
after the antenna gain setting is changed. 
PR 1353 

System Platforms 
Affected: 

 
MOTOMESH DUO 

Special 
Configurations: 

n/a 

User Symptom: After changing the antenna gain setting via the web interface 
and hitting the apply button, the transmit power setting 
displays the old value. 

Description: Issue resolved. When applying a new antenna gain value via 
the web interface, the transmit power setting doesn't get 
adjusted accordingly but rather the original value is displayed 
instead. The antenna gain field isn’t marked to indicate a 
reboot is required for the change to take effect. In this release, 
antenna configuration fields are marked for the required 
reboot. 

Work Around:  
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Updated Issue  

Note #: U-17 

Abstract: 
 
Reference Number: 

Client lost association due to second MIC error 
 
PR 2155 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

VAP with WPA/TKIP security 

User Symptom: Associated WPA/TKIP client will regularly lose association 

Description: Issue resolved. When configured for WPA/TKIP, a station 
would lose association due to the occurrence of two MIC 
errors within the MIC timeout period. The MIC timeout was 
supposed to be 60 seconds but was set to sixteen minutes 
instead. The AP would then reject any Association attempts 
for the duration of that MIC timeout period. In addition, MIC 
errors in previous firmware releases were counted per radio 
and not per VAP. Thus, there was s a higher chance of 
encountering two MIC errors within 60 seconds if there are 
two or more VAPs configured with WPA/TKIP. In firmware 
version 9.1.40, these issues were corrected so that the MIC 
timeout is set to the standard 60 seconds value and the MIC 
errors are counted per VAP not per radio. 

Work Around:  
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Updated Issue  

Note #: U-18 

Abstract: 
 
Reference Number: 

MM Duo AP may reboot when WPA PTK is used.  
 
PR 1814 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: Brief interruption in communication or a short throughput 
outage. 

Description: Issue resolved.  When using WPA PTK, the hardware keys 
aren’t handled correctly and the AP reboots when the 
hardware key cache is full. In this release, the hardware keys 
are properly handled and the AP no longer resets.  

Work Around:  

 
 

Updated Issue  

Note #: U-19 

Abstract: 
 
Reference Number: 

A station card fails to associate to AP when it switches from 
WPA2 to WPA VAP.  
 
PR 2460 

System Platforms 
Affected: 

  
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: A station card is unable to associate with an AP 

Description: Issue resolved.  A station card that moves from a 
WPA/WPA2 AES VAP to a WPA/WPA2 TKIP/Auto VAP on 
the same AP is unable to associate to the WPA/WPA2 
TKIP/Auto VAP. In this release, a station card can freely 
move between VAPs and can still associate with the AP 
(either VAP) 

Work Around:  
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Updated Issue  

Note #: U-20 

Abstract: 
 
Reference Number: 

The gateway is lost when switching from DHCP IP address to 
static IP address. 
 
PR 2417 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: The MM Duo AP becomes unmanageable when switching 
from DHCP mode to Static IP Address mode.  

Description: Issue resolved. Gateway IP Address behavior is 
inconsistent when switching from DHCP mode to Static IP 
Address mode.  Sometimes the Gateway IP Address remains 
persistent and other times the value goes to 0.0.0.0, making 
the device unmanageable.  
 
When DHCP mode is disabled, the Gateway value is 
extracted from the device boot line, which is saved in 
NVRAM and can be only set at factory (not a user 
configurable value). The default value is (0.0.0.0). In this 
release, when DHCP is disabled, the DHCP Gateway value 
is used unless the boot line value is not (0.0.0.0).  

Work Around:  
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Updated Issue  

Note #: U-21 

Abstract: 
 
Reference Number: 

The WEP key field on the web interface doesn’t have a 
length check 
 
PR 2265 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: It’s possible to exceed the appropriate WEP key length when 
configuring the AP   

Description: Issue resolved. The web interface lacked a size check when 
entering a WEP key. In this release, a size check has been 
added. 

Work Around:  

 
 

 

Updated Issue  

Note #: U-22 

Abstract: 
 
Reference Number: 

Added support for channel 165 (5.825 GHz) 
 
PR 1556 

System Platforms 
Affected: 

 
MOTOMESH Duo 

Special 
Configurations: 

 

User Symptom: Will be able to select channel 165 in the 5.8 GHz band. 

Description: Channel 165 (5.825) has been added to the list of supported 
channels for the 5.8 GHz band. 

Work Around:  

 
 

 

 

 

 

 


